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OVERVIEW

http://edu.sablab.net/sdae2013Materials:

http://edu.sablab.net/data/xlsData:

Data presentation and descriptive statistics

Discrete and continues distributions

Sampling distribution and interval estimation for the mean

Hypotheses about population mean

Analysis of Variance (ANOVA)

Linear regression

Advanced topics
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DATA AND STATISTICS

Elements, variables, and observations, 
data scales and types
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DATA AND STATISTICS

Data: Elements, Variables, and Observations

Data
The facts and figures collected, analyzed, and 
summarized for presentation and interpretation.

variableselements

Person Place Gender
Net Worth 

($BIL) Age Source
Internet Fame 

Score
William Gates III 1 M 40 53 Microsoft 9.5
Warren Buffett 2 M 37 79 Berkshire Hathaway 6.6
Carlos Slim Helu 3 M 35 69 telecom 2.1
Lawrence Ellison 4 M 22.5 64 Oracle 2.8
Ingvar Kamprad 5 M 22 83 IKEA 2.4
Karl Albrecht 6 M 21.5 89 Aldi 3.6
Mukesh Ambani 7 M 19.5 51 petrochemicals 4.4
Lakshmi Mittal 8 M 19.3 58 steel 5.4
Theo Albrecht 9 M 18.8 87 Aldi 1.5
Amancio Ortega 10 M 18.3 73 Zara 1.9
Jim Walton 11 M 17.8 61 Wal-Mart 3.9
Alice Walton 12 F 17.6 59 Wal-Mart 2.9

Person Place Gender
Net Worth 

($BIL) Age Source
Internet Fame 

Score
William Gates III 1 M 40 53 Microsoft 9.5
Warren Buffett 2 M 37 79 Berkshire Hathaway 6.6
Carlos Slim Helu 3 M 35 69 telecom 2.1
Lawrence Ellison 4 M 22.5 64 Oracle 2.8
Ingvar Kamprad 5 M 22 83 IKEA 2.4
Karl Albrecht 6 M 21.5 89 Aldi 3.6
Mukesh Ambani 7 M 19.5 51 petrochemicals 4.4
Lakshmi Mittal 8 M 19.3 58 steel 5.4
Theo Albrecht 9 M 18.8 87 Aldi 1.5
Amancio Ortega 10 M 18.3 73 Zara 1.9
Jim Walton 11 M 17.8 61 Wal-Mart 3.9
Alice Walton 12 F 17.6 59 Wal-Mart 2.9

Can we consider the “Place” as element?
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( )5.4log3 10 −= NIFS
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DATA AND STATISTICS

Data Scales and Types

Data

Q
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Nominal scale
data use labels or names to identify 

an attribute of an element.

Ex.1: Male, Female

Ex.2: Rooms #:   101, 102, 103, …

Ordinal scale
data exhibit the properties of nominal 
data and the order or rank of the data 
is meaningful. 

Ex.1: Winners:  The 1st, 2nd, 3rd places

Ex.2: Marks:   A, B, C, …

Interval scale
data demonstrate the properties of 
ordinal data and the interval between 
values is expressed in terms of a 
fixed unit of measure

Ex.1: Examination score 0 -100

Ex.2: Internet fame score ☺

Ratio scale
data demonstrate all the properties of 
interval data and the ratio of two 
values is meaningful.

Ex.1: Weight 

Ex.2: Price

scales:
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DATA AND STATISTICS

Task: Define the Scales

Person Place Gender
Net Worth 

($BIL) Age Source
Internet Fame 

Score
William Gates III 1 M 40 53 Microsoft 9.5
Warren Buffett 2 M 37 79 Berkshire Hathaway 6.6
Carlos Slim Helu 3 M 35 69 telecom 2.1
Lawrence Ellison 4 M 22.5 64 Oracle 2.8
Ingvar Kamprad 5 M 22 83 IKEA 2.4
Karl Albrecht 6 M 21.5 89 Aldi 3.6
Mukesh Ambani 7 M 19.5 51 petrochemicals 4.4
Lakshmi Mittal 8 M 19.3 58 steel 5.4
Theo Albrecht 9 M 18.8 87 Aldi 1.5
Amancio Ortega 10 M 18.3 73 Zara 1.9
Jim Walton 11 M 17.8 61 Wal-Mart 3.9
Alice Walton 12 F 17.6 59 Wal-Mart 2.9

Person Place Gender
Net Worth 

($BIL) Age Source
Internet Fame 

Score
William Gates III 1 M 40 53 Microsoft 9.5
Warren Buffett 2 M 37 79 Berkshire Hathaway 6.6
Carlos Slim Helu 3 M 35 69 telecom 2.1
Lawrence Ellison 4 M 22.5 64 Oracle 2.8
Ingvar Kamprad 5 M 22 83 IKEA 2.4
Karl Albrecht 6 M 21.5 89 Aldi 3.6
Mukesh Ambani 7 M 19.5 51 petrochemicals 4.4
Lakshmi Mittal 8 M 19.3 58 steel 5.4
Theo Albrecht 9 M 18.8 87 Aldi 1.5
Amancio Ortega 10 M 18.3 73 Zara 1.9
Jim Walton 11 M 17.8 61 Wal-Mart 3.9
Alice Walton 12 F 17.6 59 Wal-Mart 2.9

( )5.4log3 10 −= NIFS

?
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TABULAR AND GRAPHICAL 
PRESENTATION

Frequency distribution, bar and pie charts, histogr am, 
cumulative frequency distribution, scatter plot
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TABULAR AND GRAPHICAL PRESENTATION

Frequency Distribution

Frequency distribution
A tabular summary of data showing the number (frequency) of items in each of several 
nonoverlapping classes.

In MS Excel use the following functions:

=COUNTIF(data,element) to get number of “elements” found
in the “data” area

=SUM(data) to get the sum of the values in the “data” area

Marks
A
B
C
B
A
B
B
A
B
C

Mark Frequency
A 3
B 5
C 2

Total 10

Frequency 
distribution:

Mark Frequency
A 0.3
B 0.5
C 0.2

Total 1

Relative frequency 
distribution:

Percent frequency 
distribution:

Mark Frequency
A 30%
B 50%
C 20%

Total 100%
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TABULAR AND GRAPHICAL PRESENTATION

Example: Pancreatitis Study

pancreatitis.xls pancreatitis.xls 

The role of smoking in the etiology of pancreatitis has been recognized for many years. To
provide estimates of the quantitative significance of these factors, a hospital-based study
was carried out in eastern Massachusetts and Rhode Island between 1975 and 1979. 53
patients who had a hospital discharge diagnosis of pancreatitis were included in this
unmatched case-control study. The control group consisted of 217 patients admitted for
diseases other than those of the pancreas and biliary tract. Risk factor information was
obtained from a standardized interview with each subject, conducted by a trained
interviewer.

adapted from Chap T. Le, Introductory Biostatistics

Smokers Ex-smokers Ex-smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Ex-smokers Smokers Smokers
Ex-smokers Ex-smokers Smokers Ex-smokers Smokers
Smokers Never Smokers Ex-smokers Ex-smokers
Smokers Ex-smokers Smokers Smokers Ex-smokers
Smokers Smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Smokers Smokers
Smokers Smokers Smokers Smokers Smokers
Smokers Never Smokers Smokers Smokers

Smokers Ex-smokers Ex-smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Ex-smokers Smokers Smokers
Ex-smokers Ex-smokers Smokers Ex-smokers Smokers
Smokers Never Smokers Ex-smokers Ex-smokers
Smokers Ex-smokers Smokers Smokers Ex-smokers
Smokers Smokers Smokers Smokers Smokers
Ex-smokers Smokers Smokers Smokers Smokers
Smokers Smokers Smokers Smokers Smokers
Smokers Never Smokers Smokers Smokers

Pancreatitis patients:
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FREQUENCY DISTRIBUTION

Relative Frequency Distribution

Frequency distribution
A tabular summary of data showing the number 
(frequency) of items in each of several 
nonoverlapping classes.

pancreatitis.txt 

In Excel use the following functions:

=COUNTIF(data,element) to get number of 
“elements” found in the “data” area

=SUM(data) to get the sum of the values in 
the “data” area

Smoking Cases Controls
Never 2 56
Ex-smokers 13 80
Smokers 38 81
Total 53 217

Smoking Cases Controls
Never 2 56
Ex-smokers 13 80
Smokers 38 81
Total 53 217

Frequency distribution:

Relative frequency distribution:
Smoking Cases Controls
Never 0.038 0.258
Ex-smokers 0.245 0.369
Smokers 0.717 0.373
Total 1 1

Smoking Cases Controls
Never 0.038 0.258
Ex-smokers 0.245 0.369
Smokers 0.717 0.373
Total 1 1

Relative frequency distribution
A tabular summary of data showing the fraction 
or proportion of data items in each of several 
nonoverlapping classes. Sum of all values 
should give 1

Estimation of probability distribution
When number of experiments n → ∞, 

R.F.D. → P.D.
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TABULAR AND GRAPHICAL PRESENTATION

Crosstabulation

pancreatitis.xls 

Smoking other pancreatitis Total
Ex-smokers 80 13 93
Never 56 2 58
Smokers 81 38 119
Total 217 53 270

Disease
Smoking other pancreatitis Total
Ex-smokers 80 13 93
Never 56 2 58
Smokers 81 38 119
Total 217 53 270

Disease

In Excel use the following steps:

Insert → Pivot Table

Set the range, including the headers of the data 

Select output and set layout by drag-and-dropping the names into the table

 Disease
Smoking other pancreatitis Total
Ex-smoker 80 13 93
Never 56 2 58
Smoker 81 38 119
Total 217 53 270
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TABULAR AND GRAPHICAL PRESENTATION

Bar and Pie Charts

In MS Excel use the following steps:

Insert → Column → Set data range (both columns of Percent freq. distribution)

Insert→ Pie → Set data range (one columns of Percent freq. distribution)

Try to avoid using in scientific 
reports. For public/business 

presentations only!

pancreatitis.xls other

Never

Ex-smoker

Smoker

pancreatitis

Never

Ex-smoker

Smoker
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TABULAR AND GRAPHICAL PRESENTATION

Tordoff MG, Bachmanov AA

Survey of calcium & sodium intake and 
metabolism with bone and body 

composition data

Project symbol: Tordoff3

Accession number: MPD:103

Example: Mice Data Series

mice.xls 

790 mice from different strains
http://phenome.jax.org

parameter
Starting age
Ending age
Starting weight
Ending weight
Weight change
Bleeding time
Ionized Ca in blood
Blood pH
Bone mineral density
Lean tissues weight
Fat weight
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TABULAR AND GRAPHICAL PRESENTATION

Histogram

The following are weights in grams for 970 mice:

Sorted weights show that the values are in the 10 – 49.6 grams. 
Let us divide the weight into the “bins”

bins

mice.xls 

20.5 23.2 24.6 23.5 26 25.9 23.9 22.8 19.9 …
20.8 22.4 26 23.8 26.5 26 22.8 22.9 20.9 …
19.8 22.7 31 22.7 26.3 27.1 18.4 21 18.8 …
21 21.4 25.7 19.7 27 26.2 21.8 22.2 19.2 …

21.9 22.6 23.7 26.2 26 27.5 25 20.9 20.6 …
22.1 20 21.1 24.1 28.8 30.2 20.1 24.2 25.8 …
21.3 21.8 23.7 23.5 28 27.6 21.6 21 21.3 …
20.1 20.8 24.5 23.8 29.5 21.4 21.5 24 21.1 …
18.9 19.5 32.3 28 27.1 28.2 22.9 19.9 20.4 …
21.3 20.6 22.8 25.8 24.1 23.5 24.2 22 20.3 …

Weight,g Frequency
>=10 1
10-20 237
20-30 417
30-40 124
40-50 11

More 0
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TABULAR AND GRAPHICAL PRESENTATION

Histogram

In Excel use the following steps:

Specify the column of bins (interval) upper-limits

Data → Data Analysis → Histrogram → select the input data, bins, and output  
(Analysis ToolPak should be installed)

use Insert → Column  to visualize the results

Now, let us use bin-size = 1 gram
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Bin Frequency
8 0
9 1
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... ...
39 2
40 2

More 0
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TABULAR AND GRAPHICAL PRESENTATION

Cumulative Frequency Distribution

Cumulative frequency distribution 
A tabular summary of quantitative data showing 
the number of items with values less than or 
equal to the upper class limit of each class.
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TABULAR AND GRAPHICAL PRESENTATION

Scatter Plot

mice.xls Let us look on mutual dependency of the Starting and Ending weights.

In Excel use the following steps:

Select the data region

Use Insert→ XY (Scatter)
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NUMERICAL MEASURES

Population and sample, measures of location, quanti les, 
quartiles and percentiles, measures of variability,  z-score, 
detection of outliers, exploration data analysis, b ox plot, 

covariation, correlation 
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NUMERICAL MEASURES

Population and Sample

POPULATION

µ −−−− mean 
σ2 −−−− variance 
N −−−− number of elements

(usually N=∞)

SAMPLE

m,    −−−− mean
s2 −−−− variance 
n −−−− number of

elements

x

ID Strain Sex
Starting 

age
Ending 

age
Starting 
weight

Ending 
weight

Weight 
change

Bleeding 
time

Ionized 
Ca in 
blood

Blood pH
Bone 

mineral 
density

Lean 
tissues 
weight

Fat 
weight

1 129S1/SvImJ f 66 116 19.3 20.5 1.062 64 1.2 7.24 0.0605 14.5 4.4
2 129S1/SvImJ f 66 116 19.1 20.8 1.089 78 1.15 7.27 0.0553 13.9 4.4
3 129S1/SvImJ f 66 108 17.9 19.8 1.106 90 1.16 7.26 0.0546 13.8 2.9

368 129S1/SvImJ f 72 114 18.3 21 1.148 65 1.26 7.22 0.0599 15.4 4.2
369 129S1/SvImJ f 72 115 20.2 21.9 1.084 55 1.23 7.3 0.0623 15.6 4.3
370 129S1/SvImJ f 72 116 18.8 22.1 1.176 1.21 7.28 0.0626 16.4 4.3
371 129S1/SvImJ f 72 119 19.4 21.3 1.098 49 1.24 7.24 0.0632 16.6 5.4
372 129S1/SvImJ f 72 122 18.3 20.1 1.098 73 1.17 7.19 0.0592 16 4.1

4 129S1/SvImJ f 66 109 17.2 18.9 1.099 41 1.25 7.29 0.0513 14 3.2
5 129S1/SvImJ f 66 112 19.7 21.3 1.081 129 1.14 7.22 0.0501 16.3 5.2

10 129S1/SvImJ m 66 112 24.3 24.7 1.016 119 1.13 7.24 0.0533 17.6 6.8
364 129S1/SvImJ m 72 114 25.3 27.2 1.075 64 1.25 7.27 0.0596 19.3 5.8
365 129S1/SvImJ m 72 115 21.4 23.9 1.117 48 1.25 7.28 0.0563 17.4 5.7
366 129S1/SvImJ m 72 118 24.5 26.3 1.073 59 1.25 7.26 0.0609 17.8 7.1
367 129S1/SvImJ m 72 122 24 26 1.083 69 1.29 7.26 0.0584 19.2 4.6

6 129S1/SvImJ m 66 116 21.6 23.3 1.079 78 1.15 7.27 0.0497 17.2 5.7
7 129S1/SvImJ m 66 107 22.7 26.5 1.167 90 1.18 7.28 0.0493 18.7 7
8 129S1/SvImJ m 66 108 25.4 27.4 1.079 35 1.24 7.26 0.0538 18.9 7.1
9 129S1/SvImJ m 66 109 24.4 27.5 1.127 43 1.29 7.29 0.0539 19.5 7.1

ID Strain Sex
Starting 

age
Ending 

age
Starting 
weight

Ending 
weight

Weight 
change

Bleeding 
time

Ionized 
Ca in 
blood

Blood pH
Bone 

mineral 
density

Lean 
tissues 
weight

Fat 
weight

1 129S1/SvImJ f 66 116 19.3 20.5 1.062 64 1.2 7.24 0.0605 14.5 4.4
2 129S1/SvImJ f 66 116 19.1 20.8 1.089 78 1.15 7.27 0.0553 13.9 4.4
3 129S1/SvImJ f 66 108 17.9 19.8 1.106 90 1.16 7.26 0.0546 13.8 2.9

368 129S1/SvImJ f 72 114 18.3 21 1.148 65 1.26 7.22 0.0599 15.4 4.2
369 129S1/SvImJ f 72 115 20.2 21.9 1.084 55 1.23 7.3 0.0623 15.6 4.3
370 129S1/SvImJ f 72 116 18.8 22.1 1.176 1.21 7.28 0.0626 16.4 4.3
371 129S1/SvImJ f 72 119 19.4 21.3 1.098 49 1.24 7.24 0.0632 16.6 5.4
372 129S1/SvImJ f 72 122 18.3 20.1 1.098 73 1.17 7.19 0.0592 16 4.1

4 129S1/SvImJ f 66 109 17.2 18.9 1.099 41 1.25 7.29 0.0513 14 3.2
5 129S1/SvImJ f 66 112 19.7 21.3 1.081 129 1.14 7.22 0.0501 16.3 5.2

10 129S1/SvImJ m 66 112 24.3 24.7 1.016 119 1.13 7.24 0.0533 17.6 6.8
364 129S1/SvImJ m 72 114 25.3 27.2 1.075 64 1.25 7.27 0.0596 19.3 5.8
365 129S1/SvImJ m 72 115 21.4 23.9 1.117 48 1.25 7.28 0.0563 17.4 5.7
366 129S1/SvImJ m 72 118 24.5 26.3 1.073 59 1.25 7.26 0.0609 17.8 7.1
367 129S1/SvImJ m 72 122 24 26 1.083 69 1.29 7.26 0.0584 19.2 4.6

6 129S1/SvImJ m 66 116 21.6 23.3 1.079 78 1.15 7.27 0.0497 17.2 5.7
7 129S1/SvImJ m 66 107 22.7 26.5 1.167 90 1.18 7.28 0.0493 18.7 7
8 129S1/SvImJ m 66 108 25.4 27.4 1.079 35 1.24 7.26 0.0538 18.9 7.1
9 129S1/SvImJ m 66 109 24.4 27.5 1.127 43 1.29 7.29 0.0539 19.5 7.1

All existing laboratory 
Mus musculus

Sample statistic
A numerical value used 
as a summary measure 
for a sample (e.g., the 
sample mean m, the 
sample variance s2, and 
the sample standard 
deviation s)

Population parameter
A numerical value used 
as a summary 
measure for a 
population (e.g., the 
population mean µ, 
variance σ2, standard 
deviation σ)

mice.xls 790 mice from different strains
http://phenome.jax.org
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Weight
12
16
19
22
23
23
24
32
36
42
63
68

Weight
12
16
19
22
23
23
24
32
36
42
63
68

NUMERICAL MEASURES

Measures of Location

Mean
A measure of central 
location computed by 
summing the data values 
and dividing by the 
number of observations.

Median
A measure of central 
location provided by the 
value in the middle when 
the data are arranged in 
ascending order.

Mode
A measure of location, 
defined as the value that 
occurs with greatest 
frequency.

n

x
mx i∑==

n

x
mx i∑==

N

xi∑=µ
N

xi∑=µ

( )
n

truex
p i∑ =

=
( )

n

truex
p i∑ =

=

Median = 23.5

Mode = 23

Mean = 31.7
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NUMERICAL MEASURES

Measures of Location

mice.xls 

0 50 100 150 200

0.
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0
0.
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0

Bleeding time

N = 760   Bandwidth = 5.347

D
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median = 55
mean = 61
mode = 48

In Excel use the following functions:

= AVERAGE(data)

= MEDIAN(data) 

= MODE(data)

Female proportion
pf = 0.501

Histogram and p.d.f. approximation

weight, g
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NUMERICAL MEASURES

Quantiles, Quartiles and Percentiles

Percentile 
A value such that at least p% of the observations are 
less than or equal to this value, and at least (100-p)% of 
the observations are greater than or equal to this value. 
The 50-th percentile is the median.

Quartiles 
The 25th, 50th, and 75th percentiles, 
referred to as the first quartile, the second 
quartile (median), and third quartile, 
respectively.

Weight 12 16 19 22 23 23 24 32 36 42 63 68

Q1 = 21 Q2 = 23.5 Q3 = 39

In Excel use the following functions:

=PERCENTILE(data,p)
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NUMERICAL MEASURES

Measures of Variability

Interquartile range (IQR)
A measure of variability, 
defined to be the 
difference between the 
third and first quartiles.

In Excel use the following functions:

=VAR(data), =STDEV(data)

13 QQIQR −= 13 QQIQR −=

Standard deviation
A measure of variability 
computed by taking the 
positive square root of the 
variance.

2ssdeviationndardstaSample ==

2σσ ==deviationndardstaPopulation

Variance
A measure of variability 
based on the squared 
deviations of the data 
values about the mean.

( )
N

xi∑ −
=

2

2
µ

σ
( )

N

xi∑ −
=

2

2
µ

σ

( )
1

2

2

−
−

= ∑
n

mx
s i( )

1

2

2

−
−

= ∑
n

mx
s i

sample

population

Weight 12 16 19 22 23 23 24 32 36 42 63 68

IQR = 18 Variance = 320.2 St. dev. = 17.9

In Excel 2010 use the following functions:

=VAR.S(data), =STDEV.S(data)

(for a sample)
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NUMERICAL MEASURES

Measures of Variability

Coefficient of variation
A measure of relative variability 
computed by dividing the standard 
deviation by the mean. %100







 ×
Mean

deviationndardSta
%100






 ×
Mean

deviationndardSta
CV = 57%

Weight 12 16 19 22 23 23 24 32 36 42 63 68

Median absolute deviation (MAD)
MAD is a robust measure of the 
variability of a univariate sample of 
quantitative data.

( )( )xmedianxmedianMAD i −= ( )( )xmedianxmedianMAD i −=

Set 1 Set 2
23 23
12 12
22 22
12 12
21 21
18 81
22 22
20 20
12 12
19 19
14 14
13 13
17 17

Set 1 Set 2
23 23
12 12
22 22
12 12
21 21
18 81
22 22
20 20
12 12
19 19
14 14
13 13
17 17

Set 1 Set 2
Mean 17.3 22.2
Median 18 19

St.dev. 4.23 18.18
MAD 5.93 5.93

Online: http://www.miniwebtool.com/median-absolute-deviation-calculator/
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NUMERICAL MEASURES

Exploration Data Analysis

Five-number summary   
An exploratory data analysis technique that uses five numbers to summarize the data: 
smallest value, first quartile, median, third quartile, and largest value

children.xls children.xls Min. : 12  
Q1 : 25  
Median: 32  
Q3 : 46  
Max. : 79 

In Excel use:

Tool → Data Analysis → Descriptive Statistics

Q1 Q3Q2

1.5 IQR

Min MaxBox plotBox plot 
A graphical summary of data 
based on a five-number summary

In Excel use (indirect):

http://www.youtube.com/watch
?v=s8ZW4PVarwE

http://peltiertech.com/WordPress/excel-box-and-whisker-diagrams-box-plots/
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NUMERICAL MEASURES

Measure of Association between 2 Variables

Correlation (Pearson product moment correlation coe fficient)
A measure of linear association between two variables that takes on values between -1 and 
+1. Values near +1 indicate a strong positive linear relationship, values near -1 indicate a 
strong negative linear relationship; and values near zero indicate the lack of a linear 
relationship.
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In Excel use function:

=CORREL(data)

mice.xls 
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NUMERICAL MEASURES

Correlation Coefficient

Wikipedia
If we have only 2 data points in x and y datasets, 
what values would you expect for correlation b/w 
x and y ?
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DETECTION OF OUTLIERS

z-score, detection of outliers
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DETECTION OF OUTLIERS

Problem

Coefficient of variation
A measure of relative variability 
computed by dividing the standard 
deviation by the mean. CV = 57%

Weight 12 16 19 22 23 23 24 32 36 42 63 68

Median absolute deviation (MAD)
MAD is a robust measure of the 
variability of a univariate sample of 
quantitative data.

Set 1 Set 2
23 23
12 12
22 22
12 12
21 21
18 81
22 22
20 20
12 12
19 19
14 14
13 13
17 17

Set 1 Set 2
23 23
12 12
22 22
12 12
21 21
18 81
22 22
20 20
12 12
19 19
14 14
13 13
17 17

Set 1 Set 2
Mean 17.3 22.2
Median 18 19

St.dev. 4.23 18.18
MAD 5.93 5.93
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DETECTION OF OUTLIERS

z-score

z-score  
A value computed by dividing the deviation about the mean (xi x) by the standard 
deviation s. A z-score is referred to as a standardized value and denotes the number of 
standard deviations xi is from the mean.

s

mx
z i

i

−=
s

mx
z i

i

−=

Weight z-score
12 -1.10
16 -0.88
19 -0.71
22 -0.54
23 -0.48
23 -0.48
24 -0.43
32 0.02
36 0.24
42 0.58
63 1.75
68 2.03

Weight z-score
12 -1.10
16 -0.88
19 -0.71
22 -0.54
23 -0.48
23 -0.48
24 -0.43
32 0.02
36 0.24
42 0.58
63 1.75
68 2.03

Chebyshev’s theorem 
For any data set , at least  (1 – 1/z2) of the data values must be within 
z standard deviations from the mean, where z – any value > 1.

For ANY distribution:

At least 75 % of the values are within z = 2 standard deviations from the mean

At least 89 % of the values are within z = 3 standard deviations from the mean

At least 94 % of the values are within z = 4 standard deviations from the mean

At least 96% of the values are within z = 5 standard deviations from the mean
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DETECTION OF OUTLIERS

Detection of Outliers by z-score

For bell-shaped distributions:

Approximately 68 % of the values are within 1 st.dev. from mean

Approximately 95 % of the values are within 2 st.dev. from mean

Almost all data points are inside 3 st.dev. from mean

Example: Gaussian distribution

Outlier
An unusually small or unusually 
large data value.

Weight z-score
23 0.04
12 -0.53
22 -0.01
12 -0.53
21 -0.06
81 3.10
22 -0.01
20 -0.11
12 -0.53
19 -0.17
14 -0.43
13 -0.48
17 -0.27

Weight z-score
23 0.04
12 -0.53
22 -0.01
12 -0.53
21 -0.06
81 3.10
22 -0.01
20 -0.11
12 -0.53
19 -0.17
14 -0.43
13 -0.48
17 -0.27

For bell-shaped distributions 
data points with |z|>3 can be 

considered as outliers.
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DETECTION OF OUTLIERS

Task: Detection of Outliers

mice.xls Using Excel, try to identify outlier mice on the basis of 
Weight change variable

s

mx
z i

i

−=
s

mx
z i

i

−=

In Excel use the following functions:

= AVERAGE(data)  - mean, m

= STDEV.S(data) - standard deviation, s

= ABS(data)      - absolute value

sort by z-scale to identify outliers ☺☺☺☺

For bell-shaped distributions 
data points with |z|>3 can be 

considered as outliers.

More advanced is Grubbs' test for outliers (only works for reasonably normal data).

Online tool: http://www.graphpad.com/quickcalcs/Grubbs1.cfm
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DETECTION OF OUTLIERS

33

Iglewicz-Hoaglin method: modified Z-
score 

These authors recommend that modified 
Z-scores with an absolute value of 
greater than 3.5 be labeled as potential 
outliers. 

Task: Detection of Outliers

)(
)(

6745.0
xMAD

xmedianx
z i

i

−=
)(

)(
6745.0

xMAD

xmedianx
z i

i

−=

Boris Iglewicz and David Hoaglin (1993), "Volume 16: How to Detect and Handle Outliers", The ASQC Basic 
References in Quality Control: Statistical Techniques, Edward F. Mykytka, Ph.D., Editor

|z|>3.5  ⇒⇒⇒⇒ outlier

( )( )xmedianxmedianMAD i −= ( )( )xmedianxmedianMAD i −=

http://www.itl.nist.gov/div898/handbook/eda/section 3/eda35h.htm

More methods are at:
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34

Grubbs' test is an iterative method to detect outliers in a data set assumed 
to come from a normally distributed population. 

Grubbs'  Test

i
k

ki

k z
s

mx
G max

max

)(

)(

)1( =
−

=+ i
k

ki

k z
s

mx
G max

max

)(

)(

)1( =
−

=+

http://www.itl.nist.gov/div898/handbook/eda/section 3/eda35h.htm
More methods are at:

Grubbs' statistics
at step k+1:

(k) – iteration k
m – mean of the rest data
s – st.dev. of the rest data 

The hypothesis of no outliers is rejected at significance level α if

2

2

2
1

tN

t

N

N
G

+−
−> 2

2

2
1

tN

t

N

N
G

+−
−> 2

2),2/(
2

−= NNattwhere
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DETECTION OF OUTLIERS

35

Let's perform Grubb's test for "Weight change" of mice.xls

Grubbs'  Test

Step 1. Generate critical value

2

2

2
1

tN

t

N

N
GCrit +−

−= 2

2

2
1

tN

t

N

N
GCrit +−

−=

2
2),2/(

2
−= NNattwhere

N: =COUNTIF(A:A,">=0")

t2: =TINV(0.05/(2*E1),E1-2)^2

=T.INV(0.05/(2*E1),E1-2)^2

GCrit = (E1-1)/SQRT(E1)* SQRT(E2/(E1-2+E2))

Step 2. Build |z| and sort in descending order

Step 3. If the first |z| value is > GCrit – remove it and go to step 2,
else finish.

Weight change abs(x-m)/s N 790
0 9.847692462 t^2 17.51895

2.109 8.91981 G.Crit. 4.139802
0.565 4.819888341
0.578 4.704204352
0.642 4.134683177
0.658 3.992302884

Better Tool: http://graphpad.com/quickcalcs/grubbs2/
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PROBABILITY DISTRIBUTIONS

Discrete and Continuous
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Random variables

Discrete probability distributions
discrete probability distribution
expected value and variance
discrete uniform probability distribution
binomial probability distribution
hypergeometric probability distribution
Poisson probability distribution

OUTLINE

Lecture 1
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RANDOM VARIABLES

Random Variables

Random variable 
A numerical description of the 
outcome of an experiment. 

A random variable is always a numerical measure.

Discrete random variable
A random variable that may assume either a finite 
number of values or an infinite sequence of values.

Continuous random variable 
A random variable that may assume any numerical 
value in an interval or collection of intervals.

Roll a die

Number of calls to a 
reception per hour

Time between calls 
to a reception

Volume of a sample 
in a tube

Weight, height, 
blood pressure, etc
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DISCRETE PROBABILITY DISTRIBUTIONS

Discrete Probability Distribution

Probability function 
A function, denoted by f(x), that provides the probability that 
x assumes a particular value for a discrete random variable.

Probability distribution 
A description of how the probabilities are distributed over the 
values of the random variable.

Roll a die
Random variable X:

x = 1
x = 2
x = 3
x = 4
x = 5
x = 6

Probability distribution for a die roll

0
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Probability distribution for a die roll
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Number of cells under
microscope
Random variable X:
x = 0
x = 1
x = 2
x = 3
…

Probability distribution for a die roll

0

0.1

0.2

0.3

0.4

0.5
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Probability distribution for a die roll

0
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Variable x
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xf P.D. for number of cells 
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DISCRETE PROBABILITY DISTRIBUTIONS

Discrete Probability Distribution

Roll a die
Random variable X:

x = 1
x = 2
x = 3
x = 4
x = 5
x = 6

Probability distribution for a die roll

0
0.02
0.04
0.06
0.08
0.1

0.12
0.14
0.16
0.18
0.2

0 1 2 3 4 5 6 7

Variable x
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f(
x)

Probability distribution for a die roll

0
0.02
0.04
0.06
0.08
0.1

0.12
0.14
0.16
0.18
0.2

0 1 2 3 4 5 6 7

Variable x
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ro

ba
bi
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fu
nc

tio
n 

f(
x)

Variance 
A measure of the variability, or dispersion, of a random variable. 

Expected value 
A measure of the central location of a random variable, mean. ∑== )()( xxfxE µ ∑== )()( xxfxE µ

( )∑ −= )(22 xfx µσ ( )∑ −= )(22 xfx µσ
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DISCRETE PROBABILITY DISTRIBUTIONS

Discrete Uniform Probability Function

Discrete uniform probability distribution 
A probability distribution for which each possible value of the 
random variable has the same probability. n

xf
1

)( =
n

xf
1

)( =

n – number of values of x

x f(x)
1 0.1667
2 0.1667
3 0.1667
4 0.1667
5 0.1667
6 0.1667

x f(x)
1 0.1667
2 0.1667
3 0.1667
4 0.1667
5 0.1667
6 0.1667

µ = ∑(xi / n) = ∑(xi) / n

µ = 3.5
σ2 = 2.92
σ = 1.71

Probability distribution for a die roll

0
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Probability distribution for a die roll

0
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DISCRETE PROBABILITY DISTRIBUTIONS

Binomial Experiment

Binomial experiment
An experiment having the four properties:

1. The experiment consists of a sequence of n identical trials .
2. Two outcomes are possible on each trial, one called  
success and the other failure.
3. The probability of a success p does not change from trial to
trial. Consequently, the probability of failure, 1–p, does not 
change from trial to trial.
4. The trials are independent.

Example
Assuming that the probability of a side effect for a patient is 0.1. What is the probability that 
in a group of 3 patients none, 1, 2, or all 3 will get side effects after treatment? 

n trials
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DISCRETE PROBABILITY DISTRIBUTIONS

Binomial Experiment

Binomial probability distribution 
A probability distribution showing the probability of x successes in n trials of a binomial 
experiment, when the probability of success p does not change in trials.

)()1()( xnxn
x ppCxf −−= )()1()( xnxn
x ppCxf −−=Probability distribution for a binomial experiment

Probability of red p(red)=1/3, 3 trials are given. Random variable = number of “red” cases
)23(2
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f(0) = 8/27 = 0.296
f(1) = 4/9 = 0.444
f(2) = 2/9 = 0.222
f(3) = 1/27 = 0.037
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DISCRETE PROBABILITY DISTRIBUTIONS

Example: Binomial Experiment

)()1()( xnxn
x ppCxf −−= )()1()( xnxn
x ppCxf −−=Example

Assuming that the probability of a side effect for a patient is 0.1. 
1. What is the probability to get none, 1, 2, etc. side effects in a 

group of 5 patients? 
2. What is the probability that not more than 1 get a side effect 
3. What is the expected number of side effects in the group?

In Excel use the function:
= BINOMDIST(x,n,p,false)

p = 0.1
n = 5

0 1 2 3 4 5

0.
0

0.
2

0.
4

In Excel 2010 use the function:
= BINOM.DIST(x,n,p,false)
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DISCRETE PROBABILITY DISTRIBUTIONS

Practical : Binomial Experiment

Assume the probability of getting a boy or a girl are equal.
1. Calculate the distribution of boys/girl in a family with 5 children .
2. Plot the probability distribution
3. Calculate the probability of having all 5 children of only one sex

x f(x)
0 0.03125
1 0.15625
2 0.3125
3 0.3125
4 0.15625
5 0.03125

Probability distribution of having x boys 

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

0 1 2 3 4 5

Number of boys in a family

P
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bi
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y

Q3.
P(0 or 5) = P(0) + P(5)
= 0.03 + 0.03 = 0.06

Assume that a family has 4 girls 
already. What is the probability that 
the 5th will be a girl?

?
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DISCRETE PROBABILITY DISTRIBUTIONS

Hypergeometric Distribution

Example
There are 12 mice, of which 5 have an early brain tumor. A researcher randomly selects 3 
of 12. What is the probability that none of these 3 has a tumor? What is the probability that 
more then 1 have a tumor? 

Hypergeometric experiment
A probability distribution showing the probability of x
successes in n trials from a population N with r
successes and N-r failures. 

n trials
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In Excel use the function:
= HYPGEOMDIST (x,n,r,N)

In Excel 2010 use the function:
= HYPGEOM.DIST (x,n,r,N)
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DISCRETE PROBABILITY DISTRIBUTIONS

Example: Hypergeometric Distribution for Mice

Example
There are 12 mice, of which 5 have an early brain tumor. A researcher randomly selects 

3 of 12. 
1. What is the probability that none of these 3 has a tumor? 
2. What is the probability that more than 1 have a tumor? 

In Excel use the function:
= HYPGEOM.DIST (x,n,r,N)
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x f(x)
0 0.159
1 0.477
2 0.318
3 0.045

x f(x)
0 0.159
1 0.477
2 0.318
3 0.045

Q1.
P(0) =0.159

Q2.
P(>1) =P(2)+P(3)=0.364
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DISCRETE PROBABILITY DISTRIBUTIONS

Poisson Probability Distribution

Poisson probability distribution 
A probability distribution showing the probability of x occurrences of an 
event over a specified interval of time or space. 

Poisson probability function 
The function used to compute Poisson probabilities. !

)(
x

e
xf

x µµ −

=
!

)(
x

e
xf

x µµ −

=

where µ – expected value (mean)

2σµ = 2σµ =

Example
Number of calls to an Emergency Service is on average 3 per hour b/w 2 a.m. and 6 a.m. 
of working days. What are the probabilities to have 0, 5, 10 calls in the next hour?

In Excel use the function:
= POISSON(x,mu,false)
= POISSON.DIST(…)

x f(x)
0 0.050
1 0.149
2 0.224
3 0.224
4 0.168
5 0.101
6 0.050
7 0.022
8 0.008
9 0.003

10 0.001

x f(x)
0 0.050
1 0.149
2 0.224
3 0.224
4 0.168
5 0.101
6 0.050
7 0.022
8 0.008
9 0.003

10 0.001

Poisson probability density
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DISCRETE PROBABILITY DISTRIBUTIONS

Example: Poisson Distribution for Fish Counting

Example
An ichthyologist studying the spoonhead sculpin catches 
specimens in a large bag seine that she trolls through 
the lake. She knows from many years experience that on 
averages she will catch 2 fish per trolling. 

Find the probabilities of catching:
1. No fish;
2. Less than 4 fishes;
3. More then 1 fish.

In Excel use the function:
= POISSON.DIST(x,mu,false)

Glover , Mitchell, An Introduction to Biostatistics
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Q1.
P(0) = 0.135

Q2.
P(<4) = P(0)+P(1)+P(2)+P(3)=0.857

Q3.
P(>1) =1-P(0)-P(1)=0.594
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Continuous probability distribution
a continuous probability distribution
uniform probability distribution
normal probability distribution
exponential probability distribution

OUTLINE

Lecture 3
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RANDOM VARIABLES

Random Variables

Random variable 
A numerical description of the 
outcome of an experiment. 

A random variable is always a numerical measure.

Discrete random variable
A random variable that may assume either a finite 
number of values or an infinite sequence of values.

Continuous random variable 
A random variable that may assume any numerical 
value in an interval or collection of intervals.

Roll a die

Number of calls to a 
reception per hour

Time between calls 
to a reception

Volume of a sample 
in a tube

Weight, height, 
blood pressure, etc
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Probability Density

Probability density function 
A function used to compute probabilities for a continuous random variable. The area 
under the graph of a probability density function over an interval represents probability.
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Uniform Probability Distribution
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Example
The bus 22 goes every 7 minutes. You are 
coming to CHL bus station, having no idea about 
precise timetable. What is the distribution for the 
time, you may wait there?

2
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Uniform probability distribution 
A continuous probability distribution for which the probability that the random variable 
will assume a value in any interval is the same for each interval of equal length.
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Normal Probability Distribution

Normal probability distribution 
A continuous probability distribution. Its probability density function is bell shaped 
and determined by its mean µ and standard deviation σ. 
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In Excel use the function:
= NORM.DIST(x,m,s,false) for probability density function
= NORM.DIST(x,m,s,true) for cumulative probability function of normal distribution 

(area from left to x)
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Standard Normal Probability Distribution
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Standard normal probability distribution 
A normal distribution with a mean of zero and a standard 
deviation of one.

In Excel use the function:
= NORMSDIST(z)

= NORM.S.DIST(z) = 1-NORM.S.DIST(z)

In Excel 2010 use the function:
= NORM.S.DIST(z)
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Example: Gear Tire Company

Example
Suppose the Grear Tire Company just developed a new steel-belted radial tire that will be 
sold through a chain of discount stores. Because the tire is a new product, Grear's managers 
believe that the mileage guarantee offered with the tire will be an important factor in the 
acceptance of the product. Before finalizing the tire mileage guarantee policy, Grear's 
managers want probability information about the number of miles the tires will last.
From actual road tests with the tires, Grear's engineering group estimates the mean tire 
mileage is µµµµ = 36 500 miles with a standard deviation of σσσσ = 5 000. In addition, data collected 
indicate a normal distribution is a reasonable assumption. 
What percentage of the tires can be expected to last more than 40 000 miles? In other words, 
what is the probability that a tire mileage will exceed 40 000?

Anderson et al Statistics for Business and Economics
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Example: Gear Tire Company

1. Let’s transfer from Normal distribution to 
Standard Normal, then z, corresponding to 
40000 will be

7.0
5000

3650040000 =−=z

2. Calculate the “blue” area P(z >0.7) using the table:  

P(z>0.7) = 1 – P(z<0.7) = 1 – 0.5 – P(0<z<0.7) = 1 – 0.5 – 0.258 = 0.242 

Alternatively in Excel

=1-NORM.DIST(40000,36500,5000,true)
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Exponential  Probability Distribution

Exponential probability distribution 
A continuous probability distribution that is useful in computing 
probabilities for the time between independent random events.

Time between calls 
to a reception

0,0
1

)( >≥=
−

µ
µ

µ xforexf
x

0,0
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)( >≥=
−

µ
µ

µ xforexf
xσ

λ
µ == 1 σ

λ
µ == 1

Example
Number of calls to an Emergency Service is on average 3 per hour b/w 2.00 and 6.00 of 
working days. What are the distribution of the time between the calls?

xexf λλ −=)( xexf λλ −=)(

µ
0

1)()( 00

x

exFxxP
−

−==≤ µ
0

1)()( 00

x

exFxxP
−
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Cumulative probability function
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CONTINUOUS PROBABILITY DISTRIBUTIONS

Example: Exponential Distribution for Fish Counting

Example
An ichthyologist studying the spoonhead sculpin catches 
specimens in a large bag seine that she trolls through 
the lake. She knows from many years experience that on 
averages she will catch 2 fishes per trolling . Each 
trolling takes ~30 minutes .

Find the probability of catching no fish in the next hour
In Excel use the function:

= EXPON.DIST(x,1/mu,false )

1. Let’s calculate µ for this situation: µ = 30 / 2 = 15 minutes

Exponential distribution with mu=15
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2. Use either a cumulative probability function or Excel 
to calculate:

02.0)60(1)60(1)60( 15

60
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−

eFxPxP
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Thank you for your 
attention

to be continued…

QUESTIONS ?


